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Disclaimer 

While every effort has been made to ensure that the information contained in this “User Guide” is accurate and 
complete, no liability can be accepted for any errors or omissions. 

RECONYX reserves the right to change the specifications of the software described herein at any time without prior 

notice. 

RECONYX makes no warranties for damages resulting from corrupted or lost data due to a mistake in operation or 

malfunction of the camera, the software, the memory cards, personal computers, or peripheral devices 

.
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Viewing and Managing Your Images 

BuckViewTM Advanced is a complete image-handling system for pictures you take with your RapidFireTM  or 
HyperFireTM  Digital Infrared Game Cameras from RECONYX; it can also handle images taken with many other 
cameras. You can map your camera locations and land markers, organize images (by site and location), view, and 
search any or all of your images. You can also erase your memory card (see Erase Memory Card). 

 

To view and manage your images, move your mouse cursor over the RECONYX BuckView icon        on your 
desktop and double-click your left mouse button. Or from the Microsoft Windows Start menu, select 

 All Programs > RECONYX > BuckView. 

BuckView opens. 

 

BuckView has 3 primary views:  

1. Map is your main workspace for managing your land, cameras and images. 

2. Hit List gives a quick view of your favorite bucks. 

3. RECONYX News keeps you up-to-date with the latest announcements from RECONYX. 

 

The BuckView Map workspace is divided into three sections, one of which (the left) is hidden by default. The left 
section includes Memory Card, Site, and Marker Location Task Pane menus. The top middle section displays the 
site map. The bottom section shows marker locations for the current site. Standard drop-down menus appear across 
the top, along with toolbar buttons to quickly perform common tasks like viewing/loading new images, erasing your 
memory card, finding images, viewing favorite images, and displaying this user guide., placing markers on site maps, 

loading a new map, and viewing images at the current location. 

 The left and bottom sections of BuckView can be hidden or displayed (hiding sections provides more room 
to view site maps; see Manage Sites). To hide a section, click the section hide button in the middle of the 
dividing line between sections.  To display a section, click the section display button  
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 in the middle of the line along the edge of BuckView. You can also display and hide 
the right section of the “Load New Images Wizard” (see Load New Images), and the left sections of 

“Location Viewer” (see View Images) and “Site/Location Search” (see Search Images). 

Note: When a section is hidden, the section display button replaces the section hide button, and vice versa. 
Buttons shown in the preceding examples are for the bottom section. The left section (Task Pane) is hidden 
and displayed using a similar, vertical button in the middle of the dividing line between sections (the vertical 
button is bounded by arrows pointing left or right, depending on whether the section can be hidden or 

displayed, respectively). 

Tip: The Task Pane can also be hidden by un-checking Task Pane on the View drop-down menu; 
the Task Pane can be displayed by checking Task Pane on the View drop-down menu.  

 Task Pane menus can be expanded or contracted. To contract a menu, click the contract button  to the 

right of the menu name. To expand a menu, click the expand button.  

Note: When a Task Pane menu is contracted, the expand button replaces the contract button, and vice 
versa. 

 The size of the left and bottom sections of BuckView can be adjusted. Move your mouse cursor over the 
dividing line between the sections,  and when you see the cursor change to a double-
headed arrow, click and hold your left mouse button. Then move the dividing line and release your mouse 
button when the sections are the sizes you want them. You can also adjust sizes of the right section of the 
“Load New Images Wizard” (see Load New Images), and the left sections of “Location Viewer” (see View 

Images) and “Site/Location Search” (see Search Images). 

Select the task that you want to perform: 

Manage Image Folders – Change the location where imported images are stored.  This can be done by selecting 
“Tools” from the top menu and then “Image Folder Settings”. 

Manage Sites – Select a site (property or area where you set up your camera in one or more locations) to work with, 
rename and delete sites, search images in a site, add a site map, place or remove camera markers, and add new 

sites. 

Manage Locations – Select a location (specific spot within a site where you set up your camera) to work with, 
rename and delete locations, view images stored in a location, load new images into a location, create new locations, 

and place or remove camera markers representing locations on a site map. 

Erase Memory Card – Format new memory cards to prepare them for use, and erase used cards to quickly delete 
old images. 

Check Free Space – Check your memory card for free space.  

Load New Images – Load (copy) any or all images from your memory card to your computer. You can also load 
images from one folder on your computer into any of your sites and locations. An image viewer for previewing images 

before you load them is included in the “Load New Images Wizard.”  

View Images – View images that you‟ve loaded onto your computer. You can also copy images to your “favorites,” 
save images to another folder, move or copy images from one location to another, and delete images using the 

“Viewer.” 

Favorites – Add your “favorite” images to a folder for easy reference across sites and locations.  

Search Images – Search Image Data of all images in a site (including all locations in the site), or search the Image 

Data of all images in a location. 
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Tag Images and Manage Image Data – Setup a Hit List of your favorite bucks. Tag images that have captured a 
photo of your Hit List bucks. Count bucks, does or other animals captured in your photos. Add or edit narrative Image 

Data, and view all Image Data stored with an image. 

Create Video – Use any of the images you‟ve stored in a location to create a video clip. 

Manage Image Folders 

By default, BuckView stores all imported images into the folder “RECONYX Images” inside of your “My Pictures” 
folder.  Inside that RECONYX folder, each site you‟ve created has its own folder with sub-folders for each camera 
location within that site.  The images are stored in these camera location folders.   

BuckView gives you the option of changing the location of that highest level folder so you can store your images 
anywhere you choose, including on a shared network drive.  This can be done by selecting “Tools” from the top menu 
and then “Image Folder Settings”.   

On the new window that pops up, click “Add.”  

 

You can type in the new folder location, or press the “…” button on the right to select a folder.  Then click “Save.”  
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The new folder will appear in the list.  To changes the Current Folder, select one in the list and click “OK.”  The folder 
list is saved, making it easy to change between folders in the future. 

 

Images are not modified or removed when you change image folders.  If you change folders, your sites, maps, 
camera markers, and images will not be available within BuckView – that is, until you switch back to the original 
folder location.  If you change back to the original folder, everything will be there as you saw it before.   

Manage Sites 

Use the Site drop-down menu at the top of BuckView to select the current site, rename a site, delete a site, find 
images for a site, load a site map, place a  marker, and create a new site. You can also use the Site Task Pane 
menu in the left (hidden by default) section of BuckView to perform many of these tasks (these and other alternate 

instructions, where available, are also included in this user guide). 

1. To create a new site, from the Site drop-down menu, select Add Site. Or, in the Site Task Pane menu, click 
Create a new site. 
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Enter the Name of your new site. 

If you have an internet connection and want to make the most of your BuckView mapping tools, choose Online 
site. If you do not have internet access or wish to manage your maps while you are “in the field” then choose 

Offline site. 

Note: A Site may have both an Online and Offline map. Your location folders and all images are accessible and 
shared by both the Online and Offline maps. What are not shared are the drawing tools (camera markers and 

other icons, trails maps, property boundaries, etc.) For more details see Mapping Tools. 

Click OK to create your new site and close “Create a New Site.” Click Cancel to close “Create a New Site” 
without creating a new site. 

2. To select an existing site to work with (the current site), from the Site drop-down menu, select Current Site, 
and then choose the site you want to work with from the list that appears. Or, in the Site Task Pane menu, 

Choose a site from the drop-down list. 

3. To rename the current site, from the Site drop-down menu, select Rename Current. Or, in the Site Task 
Pane menu, click Rename site. 

 

Enter the new Name for your site. 

Click OK to change the name of your site and close “Rename Site.” Click Cancel to close “Rename Site” without 

changing the name of your site. 

4. To delete the current site, from the Site drop-down menu, select Delete Current. Or, in the Site Task Pane 

menu, click Delete site. 
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Important! When you delete a site, all images in all camera locations for that site are deleted. You will be asked 
to confirm that you want to delete the current site. Click Yes to delete the site. Click No to keep the site and 

cancel the deletion process. 

Note: You must have at least one site in BuckView (if you have only one site, you cannot delete that site). 

5. To search the images in the current site, from the Site drop-down menu, select Find Images. Or, click the 
Find Images toolbar button.  

 

“Site Search” opens (where Site is the name of your current site). Searches that you perform in this search 
window will search all images in the current site. See Search Images for detailed instructions on searching your 

images. 

6. To add a site map to the current site for display in the top right section of BuckView, follow the steps below 

for Offline or Online sites. 
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For Offline sites:  
 
From the Site drop-down menu, select Load Map. Or, in the Site Task Pane menu, click Load a new 
map. 
 
Tip: You can also click the Load a new map toolbar button. 
 

 
 
Important! When you load a map, all camera markers for that site will be deleted, although no images 
will be lost. You will be asked to confirm that you want to load a new map for the current site. Click 
Continue to load a new map, and proceed to browse to the map or aerial photograph you want to 
display for the current site. Click Cancel to keep the current map and cancel the deletion process. 
 
Tip: When you‟re asked to confirm that you want to load a new map for the current site, you can also 
access information to help you obtain maps from Microsoft TerraServer website. Click Help me find a 
map of my land to view instructions for downloading public domain aerial photos and topographical 
maps from TerraServer. 
 
Once you‟ve selected a site map, you can Place Camera Markers on the map to represent locations in 
the site (see Manage Locations). 

For Online sites: 
 
Online sites use Google Maps™ mapping service and RECONYX mapping technology to provide you 
with an interactive camera and image management experience.  
 
Online sites start with a default view of North America. Use the navigation tools on the map to zoom 
in/out and scroll/pan to locate your land. 

Tip: You can click on the Globe icon  in the upper left of the map to open the map search control 
and Search for a location: 

 

 
Once you‟ve located your site, you can place a variety of markers on the map to represent locations in 

the site (see Manage Locations). You can also use drawing tools to map your land. 
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Manage Locations 

Note: Locations displayed in the Location drop-down menu, the Camera Location Task Pane menu, and Camera 

locations in the bottom section of BuckView are for the current site (see Manage Sites). 

Use the Location drop-down menu at the top of BuckView to select the current location, rename a location, delete a 
location, find images in a location, view images for a location, load new images from your camera‟s memory card or 
another directory into a location, and add a new location. You can also use the Camera Location Task Pane menu 
in the left section of BuckView (hidden by default) to perform some of these tasks (these and other alternate 

instructions, where available, are also included in this user guide). 

If the current site includes a map (see Manage Sites), you can place and remove camera markers to represent your 

camera locations on the map. 

1. To select a different location to work with (the current location): from the Location drop-down menu, select 
Current Location and then choose the location you want to work with from the list that appears. Or, in the 

Marker Locations Task Pane menu, Choose a location from the list. 

Tip: You can also click the location you want to work with from the Marker locations displayed in the bottom 
section of BuckView to make it the current location. Or, if the location you want to work with is associated with a 

map marker, you can click the marker of the location that you want to select. 

2. To rename the current location, from the Location drop-down menu, select Rename Current. 

Tip: You can also click the Other button in the Marker locations (bottom) section of BuckView and from the 
menu that appears, select Rename Location. 

 

Change the Name of the location. 

Click OK to save your changes and close “Rename Location.” Click Cancel to close “Rename Location” without 

saving your changes. 

3. To delete the current location, from the Location drop-down menu, select Delete Current. 

Tip: You can also click the Delete button in the Marker locations (bottom) section of “BuckView.” 

Important! When you delete a location, all images in that location are deleted. You will be asked to confirm that 
you want to delete the current location. Click Yes to delete the location. Click No to keep the location and cancel 

the deletion process. 

4. To search the images in the current location, from the Location drop-down menu, select Find Images. Or, in the 

Marker Location Task Pane menu, click Search images. 

Tip: You can also click the Other button in the bottom right corner of BuckView, and from the menu that 
appears, select Search Location. 

“Location Search” opens (where Location is the name of your current location); this will search all images in the 

current location. See Search Images for detailed instructions. 
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5. To view images for the current location, from the Location drop-down menu, select View Images. Or, in the 

Marker Location Task Pane menu, click View Images. See View Images for detailed instructions. 

6. To place a camera marker: 

For Offline sites:  
 
From the Site drop-down menu, check Place Camera Marker. Or, click the site‟s Place Camera 
Marker toolbar button. 
 

Note: When your mouse cursor looks like a green map pin , “Place Camera Marker” appears any 

time you click on the site map. Your mouse cursor will automatically switch back to “standard” after 
you place your marker, or cancel the marker-placing process. 
 

Tip: Once you place a marker on a map, it appears as a green map pin with a red center.  You can 
change locations by clicking the marker of the location you want to select. The selected marker has a 

blue background.  
 

 
 
Select whether you want to Create a new camera location (and enter the Name of the new location), 
or Associate with an existing camera location  (and select the location from the list of Camera 
Locations that are not yet marked on the site map). 
 
Click OK to place the camera marker for this location and close “Place Camera Marker.” Click Cancel 

to close “Place Camera Marker” without adding a camera marker. 
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For Online sites:  
 
Click on the Marker Type of your choice from the toolbox above the map. 
 
Tip: To see more markers, click on the grey down arrows on the right side of the markers toolbox 
(noted by the green arrow below). Hold your cursor over any marker to see a description of the marker. 

 
 
Your cursor will change to match the marker you have selected. Move the marker over the map and 
click to drop it at your selected position. 
 

\ 
 
Select whether you want to Create a new camera location (and enter the Name of the new location), 
or link the marker to an Existing Location (and select the location from the list of locations that are not 
yet marked on the site map). 
 
Tip: Online sites let you choose many types of markers and link images to them. You may choose to 
store your images under any marker folder or only use camera markers as image storage folders. 
 
Click OK to place the camera marker for this location and close “New Camera.” Click Cancel to close 

“New Camera” without adding a camera marker. 
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7. To load new images into the current location, from the Location drop-down menu, select Load New Images, 
and then select where you‟re loading images from (From Memory Card or From Another Folder). See Load 

New Images for detailed instructions. 

Tip: The “Load New Images Wizard” includes an image viewer; you will be able to examine your images before 
deciding which – if any – you want to load on to your computer. 

8. To remove the current site‟s camera marker from the map 
 

For Offline sites:  
 
Move your mouse cursor over the marker, click your right mouse button, and from the menu that 
appears, select Remove Camera Marker. Or, click the Other button in the in the bottom right corner of 
BuckView, and from the menu that appears, select Remove Camera Marker. 
 
Tip:  If you want to move the current location‟s camera marker from one position on the map to another, 
you must first remove the existing camera marker for the current site (use Remove Camera Marker) 
and then place a new camera marker and associate it with the site (use Place Camera Marker). 

For Online sites:  
 
Click on the marker and from the popup window, choose Delete. Or, click the Other button in the in the 

bottom right corner of BuckView, and from the menu that appears, select Remove Camera Marker. 

 
Tip:  If you want to move the current location‟s marker from one position on the map to another, can 

just click and drag the marker to the new position. 

  

9. To create a new location, from the Location drop-down menu, select Add Location. 

Tip: You can also click the Add button in the bottom right corner of “BuckView.” 

 

Enter the Name of the location you‟re adding. 

Click OK to create your new location and close “Add Location.” Click Cancel to close “Add Location” without 
creating a new location. 
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Erase Memory Card 

Your memory card must be formatted FAT or FAT32 for use with your RapidFireTM or HyperFireTM camera and 
BuckViewTM software. If you are uncertain of the formatting of your memory card, use BuckView to erase the card; 

erasing the card also properly formats it for use with your camera. 

Note: You must have permissions set on your computer to allow you to format removable media. If you cannot format 
memory cards using BuckView, check with computer technical support personnel to be sure you have permissions 
set properly. Troubleshooting and Technical Support also includes instructions for how to set up formatting 

privileges.   

Tip: If you are using a laptop computer, consider a PCMCIA adapter card for accessing memory cards as they are 
more convenient than USB card readers. 

Erasing a used card after you‟ve loaded the images you want to save onto your computer is a much quicker method 
of clearing the card than deleting the images. Options for erasing your memory card are available in the “Load New 

Images Wizard” (see Load New Images). 

To erase your memory card: 

1. Insert the card in your computer‟s memory card reader and from the Tools drop-down menu, select Memory 
Card, and then select Erase (Format). Or, in the Memory Card Task Pane menu, click Erase Memory card. 

Tip: You can also click the Erase Memory card toolbar button. 

 

Note: Erasing a Memory card will delete all images and other information on the card. You will be asked to 

confirm that you want to erase the card. Click Yes to erase the card. Click No to cancel the process. 

2. Erasing is completed automatically. 
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Check Free Space 

You can check your memory card for free and used space. 

To check the free space available on your memory card: 

1. Insert the card into your computer‟s memory card reader and from the Tools drop-down menu, select Memory 
Card, and then select Check Free Space. Or, in the Memory Card Task Pane menu (hidden by default), click 
Check free space. 

2. “Memory Card Status” opens. 

 

The memory card is displayed as a lettered drive with available free space displayed as a percent. 

Load New Images 

The process of loading new images is automated by the “Load New Images Wizard.” The way that you start the 
“Load New Images Wizard” depends on if you know where you want to load the images, or if you want to choose the 

site and location where you want to load the images after you select the specific images you want to load. 

Note: The “Load New Images Wizard” includes an image viewer; you will be able to examine your images before 

deciding which – if any – you want to load on to your computer. 

 If you want to load new images into the current site and location, click the arrow at the right of the 
View/Load New Images toolbar button (located above the Task Pane menus) and from the menu that 

appears, select the location you‟re loading images from: From Memory Card or From Another Folder. 

 

Tip: If you‟re loading images from your memory card and you want to load new images to the current site 
and location, you can also click the View/Load New Images toolbar button itself (not the arrow). Or, from 

the Tools drop-down menu, select Memory Card, and then select Load New Images. 

 If you want to load new images into a different location within the current site, select the location you want in 
Marker locations (in the bottom section of BuckView) and then click the Other button in the bottom right 
corner of BuckView” Then, from the menu that appears, select Load New Images, and then select From 

Memory Card or From Another Folder. 
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Note: You can also move your mouse cursor over the location in Marker locations and click your right 
mouse button. From the menu that appears, select Load New Images, and then select From Memory 

Card or From Another Folder. 

 If you want to decide the site and location you want to load new images into after you select the specific 
images you’re going to load, from the Location drop-down menu, select Load New Images, and then 

select the location you‟re loading images from: From Memory Card or From Another Folder. 

Note: If you‟re loading images from your memory card and you want to decide the site and location you 
want to load images into after you select the images you’re going to load, in the Memory Card Task Pane 
menu, select View/Load new images. 

On screens within the wizard: 

 Click Erase Memory Card to remove all images from the card (see Erase Memory Card). 

Note: This button is not available when you‟re loading new images from another folder. 

 Click Back to return to the previous screen in the wizard. 

 Click Next to advance to the next screen in the wizard. 

 Click Cancel to close the wizard without loading any images. 

 Click Finish to close the wizard after image loading is complete. 

 

1. If you’re loading new images from a memory card, the “Load New Images Wizard” displays the “Choose Source 

Folder(s)” screen. 

Select the folder or folders on your memory card that you want to load images from. As you make your 
selection(s), a preview of the first image in the selected folder appears at the right. Click Next to continue. 

 To select an individual folder for loading, click the checkbox to the left of the folder‟s name (so that a 
checkmark appears in the box). To un-select a folder, click the checkbox to the left of the folder‟s name 
(so that no checkmark appears in the box). 

 To quickly check all folders for loading, click Check All. 

 To quickly un-check all folders (so that no folders are selected for loading), click Un-Check All. 

If you’re loading new images from another folder on your computer, the “Load New Images Wizard” displays 
“Browse for Folder.” Select the folder you‟re loading images from and click OK. 

2. The “Load New Images Wizard” displays the “Choose Images” screen. Images within the available source 

folder(s) are displayed. 
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Select the image or images that you want to load. As you make your selection(s), the Checked/Total in the 
center of the screen above the image viewer updates the number of images you‟ve checked, and also displays 
the total number of images available for loading. Click Next to continue. 
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The image viewer is divided into two sections: thumbnail images on the left, and an enlarged view of the current 
thumbnail on the right. The right section can be hidden or displayed. 

Note: You can adjust the size of the right section of the image viewer, and hide or display this section as well 
(see Viewing and Managing Your Images). 

At any time when the image viewer is open (with the enlarged image section displayed or hidden): 

 To select an individual image for loading, click the checkbox to the left of the image (so that a  
checkmark appears in the box). To un-select an image, click the checkbox to the left of the image (so 

that no checkmark appears in the box). 

 To mark all images in a sequence, click the first image you want to load (not the image‟s checkbox). 
Press and hold the Shift key on your keyboard, click the last image in the sequence you want to select, 
and then release the Shift key. All of the image names from the first image you clicked to the last image 
you clicked are highlighted. Click the checkbox of any highlighted image to select all of the highlighted 
images for loading (or click Check Selected Images). You can un-check a sequence of selected 

images in the same way. 

 To quickly select all images for loading, click Check All. 

 To quickly un-select all images (so that no images are marked for loading), click Un-Check All. 

When the image viewer‟s enlarged image section is displayed: 

 To select the current image for loading, check the Checked checkbox under the enlarged image. To 
un-select the current image for loading, un-check the Checked checkbox under the enlarged image. 

 To view the previous image, click the Previous Image button.  

 To view the next image, click the Next Image button.  

 To view the images in a slideshow (automatically advancing display), click the Start Slide Show button.  

 

You can adjust the speed of the display by clicking Slow, Med(ium), or Fast, as desired. Click Stop 

Slide Show at any time after the slideshow begins to stop it. 

Tip: Clicking the displayed image will also stop the slideshow.  

Note: When the slideshow is playing, the Stop Slide Show button replaces the Start Slide Show 
button, and vice versa. 

You can also change the interval of images in the slideshow. Every image is shown by default (Show 
every 1 image.); increasing this value will display fewer images in the slideshow, allowing you to view 

the sequence more quickly.  

 To view image data for the current image, click view image data button (above the upper right corner of 

the enlarged image).  

Note: You can view image data when you‟re using the image viewer in the “Load New Images Wizard,” 

but you cannot edit it. See Tag Images and Manage Image Data to add, edit, or delete image data. 

3. If you started the “Load New Images Wizard” using the View/Load New Images toolbar button or the Tools 
drop-down menu option for loading images, the “Load New Images Wizard” displays the “Choose Camera 
Location” screen. 

Select the Site and Location where you want to load the images you selected. If you want to load the images 
you selected into a new location, select the Site where you want the new location and click Add a new location. 
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“Add Location” opens. 

 

Enter the Name of the location you‟re adding. 

Click OK to create your new location and close “Add Location.” Click Cancel to close “Add Location” without 
creating a new location. 

Click Next to continue. 

If you started the “Load New Images Wizard” using another method, skip to step 4. 

4. The “Load New Images Wizard” displays the “Summary” screen. The total number of images you‟ve selected to 
load and the folders from and to which you‟re loading those images are displayed for your review. Click Next to 

continue. 

Tip: If you‟re loading new images from a memory card and want to erase the card after the images you selected 
are loaded onto your computer, check Erase card after saving images. This option is not available if you‟re 

loading new images from another folder. 

5. The “Load New Images Wizard” displays the “Copying Images” screen. The progress of copying the images you 

selected is displayed and you will be notified when the process is complete. Click Finish to exit the wizard. 

Note: Errors, if any, are listed after the process is complete. See Troubleshooting and Technical Support. 

View Images 

You can view images that you haven‟t loaded from your memory card onto your computer using the image viewer 
that‟s included in the “Load New Images Wizard” (see Load New Images). You can also view images that you‟ve 
already loaded onto your computer. The “Viewer” behaves similarly to the image viewer that‟s included in the “Load 
New Images Wizard,” but includes many additional features, such as the ability to print images and create videos 

from images, search images, zoom in and out on images, and copy images as favorites (see Favorites). 

Note: When you view images, images are displayed from the current site and location. Before beginning the viewing 

process, select the site (see Manage Sites) and location (see Manage Locations) you want to view images for. 

To open the “Viewer:” 

 To view images in the current site and location, from the Location drop-down menu, select View Images. 
Or, in the Camera Location Task Pane menu, click View images. Or, in the Location toolbar, click the 

View Images at Location button (where Location is the name of the current location). 

 

Tip: You can also view images from any Camera location by moving your mouse cursor over that location 
in the list at the bottom of BuckView and double-clicking your left mouse button, or by selecting the Camera 
location and clicking the Other button (select View Images from the menu that appears). And, if the 
location is marked on the site map, you can move your “standard” mouse cursor over the camera marker, 

click your right mouse button, and from the menu that appears, select View Images. 

The viewer window opens. 
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The title of the viewer is “Location Viewer” (where Location is the name of the current location), and images in this 
viewer are for this location only. 

The viewer is divided into two sections: available images (thumbnail or detail view styles) on the left, and an enlarged 
view of the current list on the right. The left section can be hidden or displayed (hiding this section displays the 

enlarged image only). 

Images can be listed in thumbnail view (by image name, with a reduced-size version of the image also displayed) or 
detail view (by image name): 

 To list your images in detail view, select Detail for the View Style at the top of the left section of the viewer, 

or from the View drop-down viewer menu, select Detail. 

 To list your images in thumbnail view, select Thumbnail for the View Style, or from the View drop-down 
menu, select Thumbnail. 

Note: You can adjust the size of the left section of the viewer, and hide or display this section as well (see Viewing 

and Managing Your Images). 

To move through the images in this location, use the navigation buttons underneath the enlarged image display. 

1. To view any image in the right section of the viewer in enlarged view, click the image you want in the list. This 
image is the current image. 

2. To display the image before the current image, click the Previous Image button.  

Tip: You can also use the left arrow key on your keyboard to switch to the previous image. 

3. To display the image after the current image, click the Next Image button.  
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Tip: You can also use the right arrow key on your keyboard to switch to the next image. 

4. To view the images in a slideshow (automatically advancing display), click the Start Slide Show button.  

 

You can adjust the speed of the automatic display by clicking Slow, Med(ium), or Fast, as desired. Click Stop 

Slide Show at any time after the slideshow begins to stop it. 

Tip: Clicking the displayed image will also stop the slideshow. 

Note: When the slideshow is playing, the Stop Slide Show button replaces the Start Slide Show button, and 
vice versa. 

You can also change the interval of images in the slideshow. Every image is shown by default (Show every 1 
image.); increasing this value will display fewer images in the slideshow, allowing you to view the sequence 

more quickly. 

5. To print the current image, from the File drop-down menu, select Print. 

Tip: You can also click the Print toolbar button.  

6. To create a video from a series of images, select the images you want to include in the video and from the File 
drop-down menu, select Create Video. See Create Video for more information. 

Tip: You can also click the Create Video toolbar button.  

7. To view, add to, or edit the current image‟s Image Data, from the Image drop-down menu, select Image Data. 

“Add/Edit Image Data” opens. See Tag Images and Manage Image Data for more information. 

Tip: You can also click the Image Data toolbar button.  

8. To search the images, click the Search Location toolbar button.   

“Location Search” opens (where Location is the name of the current location). Searches that you perform in this 

search window will search all images in the current location. See Search Images for more information. 

9. To zoom in on the current image, you can choose from 3 options : 

1. Auto Fit: this will automatically size the image 
for best fit within the viewing area. 

2. Full Size: this will show the image in its full original 
size. The image will likely be larger than the viewing  
area so you may need to scroll up/down or left/right 

to see portions of the image. 

3. Custom: this will allow you to zoom the image in or out from 25% to 500% of the original image 
size. You can adjust the zoom level by setting the zoom percentage in the number field that is 
shown next to the Zoom type:        You can also use your mouse 
 
 wheel to zoom in and zoom out. As you move to the next image, the zoom level is maintained.  
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The “Viewer” also includes options for copying images to your favorites, saving images to another folder on your 
computer, exporting image data, moving or copying images to another location, and deleting images. All of these 

tasks can be performed on an individual image (the current image) or on multiple images. 

 To select multiple images that are all adjacent to one another in the list of available images, move your 
mouse cursor over the first image you want to select and click your left mouse button. Then, press and hold 
the Shift key on your keyboard. While holding the Shift key, move your mouse cursor over the last image 
you want to select and click your left mouse button. All images listed between the first image you clicked 
and the last image you clicked are selected. 

 To select multiple images that are not adjacent to one another in the list of available images, move your 
mouse cursor over any one of the images you want to select and click your left mouse button. Then, press 
and hold the Ctrl key on your keyboard. While holding the Ctrl key, move your mouse cursor over another 
image that you want to select and click your left mouse button, repeating until all the images you want are 

selected. 

1. To copy the selected image(s) to your favorites, from the File drop-down menu, select Copy Image(s) to 

Favorites. The image is copied into your Favorites folder.  

Tip: You can also click the Copy to Favorites toolbar button.  

Note: To view your favorite images, see Favorites. 

2. To save the selected image(s) into another folder on your computer, from the File drop-down menu, select Save 

Image(s) to and browse to the folder you want to save the image(s) in. 

3. To remove the selected image(s) from this location and put it in another location, from the Image drop-down 
menu, select Move to Another Camera Location. 

“Move to location” opens. 

 

Select the Site and Location where you want to move the selected image(s). 

Click OK to move the image(s) and close “Move to location.” Click Cancel to close “Move to location” without 

moving the image(s). 

4. To copy the selected image(s) and put the copy(ies) in another location, from the Image drop-down menu, select 
Copy to Another Location. 
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“Copy to location” opens. 

 

Select the Site and Location where you want to copy the selected image(s). 

Click OK to copy the image(s) and close “Copy to location.” Click Cancel to close “Copy to location” without 
copying the image(s). 

5. To delete the selected image(s), from the Image drop-down menu, select Delete. You will be asked to confirm 
that you want to delete the image. Click Yes to delete the image(s). Click No to keep the image(s) and cancel 

the deletion process. 

Tip: Several of the menu options in the File and Image drop-down menus in the “Viewer” are also available when 
you move your mouse cursor over a thumbnail or detail image name in the list of images on the left side of the viewer 
window and click your right mouse button: Image Data, Print, Create Video, Copy Image(s) to Favorites, Save 

Image(s) To, and Delete. 

 

A “MultiViewer” is also available to display two, three, or four images at the same time. 

 To select two, three, or four images that are all adjacent to one another in the list of available images, move 
your mouse cursor over the first image you want to select and click your left mouse button. Then, press and 
hold the Shift key on your keyboard. While holding the Shift key, move your mouse cursor over the last 

image you want to select and click your left mouse button.  

 To select two, three, or four images that are not adjacent to one another in the list of available images, move 
your mouse cursor over any one of the images you want to select and click your left mouse button. Then, 
press and hold the Ctrl key on your keyboard. While holding the Ctrl key, move your mouse cursor over 
another image that you want to select and click your left mouse button, repeating until all the images you 
want to view are selected. 

 From the View drop-down menu, select Side By Side. The “MultiViewer” opens with the selected images 
displayed. 

Note: You can have multiple MultiViewers open at the same time. 
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Favorites 

You can add your “favorite” images (images that you want be able to reference quickly, across locations and even 
across sites) so that you can open the “My Favorite RECONYX Images Viewer” and view all your favorite images 
together. You can also access the folder that contains your favorites and use Microsoft Windows options to order 

prints online and copy images to a CD. 

Note: You can add images to your Favorites folder from any “Viewer” that you‟re looking at the images in (see View 

Images).  

1. To view your favorites, from the Favorites drop-down menu, select View Favorite Images. Or, click the View 
Favorite Images toolbar button. 

 

The “My Favorite RECONYX Images Viewer” opens. This viewer operates the same as any other, but instead of 
displaying images by site or location, it displays only your favorites.  

2. To open your Favorites folder, from the Favorites drop-down menu, select Open Favorites Folder. The My 
Favorite RECONYX Images folder opens, including a Pictures Tasks task panel menu on the left side. Select 

the images you want to work with and the tasks you want to perform. 
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Note: Certain tasks do not appear in the list of task panel menus until you select one or more images. For 
example, E-mail this file (or E-mail the selected items if you‟ve selected multiple images) does not appear in 

File and Folder Tasks until you select an image or images. 

Search Images 

You can search Image Data of all images in a site (including all locations in the site), or search the Image Data of all 

images in a location. The “Search” is the same in both cases. 

Note: When you search images, images in your search results are displayed from the current site or current location. 
Before beginning the search process, select the site (see Manage Sites) or location (see Manage Locations) you 

want to search. 

The way that you start the “Search” from within BuckView depends on whether you want to search an entire site or a 

specific location within a site. 

 To search all images in the current site, click the Search Site toolbar button. 

 Or, from the Site drop-down menu, select Search Site. 

 To search all images in the current location, from the Location drop-down menu, select Search Location. 
Or, in the Camera Location Task Pane menu (hidden by default), click Search Location. 

Tip: You can also click the Other button in the bottom right corner of “BuckView,” and from the menu that 

appears, select Search Location. 

You can also start a search from within the “Viewer” (see View Images). 

 
The title of the search window is “Site Search” (where Site is the name of the current site) if you‟re searching images 
in all locations in the current site, and “Location Search” (where Location is the name of the current location) if you‟re 
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searching images from the current location. Images that you find in searches in this window are from the current site 

or current location only, as noted in the title of the window. 

Note: In site searches, you can choose to limit your search to locations within the site using the Location Filter. In 

location searches, you can only search the location you selected. 

Note: You can adjust the size of the left section of the search, and hide or display this section as well (see Viewing 
and Managing Your Images). 

 

There are 2 ways to search a Site or Location: Basic Search or Advanced Search. 

Basic Search 

1. Choose whether to limit the search to a certain Date Range. If so, check the box by the Start Date and/or End 
Date to limit your search to images within that time frame. 

2. To search any of the Notes you may have added to your images, enter the text into the Notes Contain field. 

3. If you want to limit the search to only images containing bucks on your Hit List, choose Hit List in the Tagging 
dropdown box and then check each Hit List buck that you wish to include. 
 
Alternatively, you can search only the images where you have entered Count data. Choose Counts from the 
Tagging dropdown and the check each species you would like to search. The results will only include images 

where you have marked that 1 or more of these species show in the image. 

4. If you’re searching a site and want to limit your search to a location within the site to search, select that location 

from the list in Location Filter. 

If you’re searching a location, the Location Filter is not available.  

5. Click Search to perform your search. The total number of images found that match your search is displayed 
above the search results area, and a full-size version of the first image found is displayed to the right of the 

search section. 
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Advanced Search 

1. Choose the Advanced Search radio button. 

2. Click on Define Advanced Search to open the Advanced Search dialog. 
 

 

3. Choose any Image Data field or Tagging field on the left. 

4. Click one of the double-arrow buttons to move the selected search field into one of the 3 search groups: 
INCLUDE images meeting ALL of these conditions (the image must satisfy every condition in this list) 
INCLUDE images meeting ANY of these conditions (the image must satisfy only 1 condition in this list) 

EXLUDE images meeting ANY of these conditions (the image must not have ANY of the conditions in this list) 

5. Click OK to close the Advanced Search window and execute the Search. 

6. If you’re searching a site and want to limit your search to a location within the site to search, select that location 
from the list in Location Filter and click Search to re-run the last search. 
 
If you’re searching a location, the Location Filter is not available. 

 



28 © RECONYX, Inc. 

 Search Results 

Images can be listed in thumbnail view (by image name, with a reduced-size version of the image also 
displayed) or detail view (by image name): 

 To list your images in detail view, select Detail for the View Style at the top of the list of search results, 

or from the View drop-down viewer menu, select Detail. 

 To list your images in thumbnail view, select Thumbnail for the View Style, or from the View drop-
down menu, select Thumbnail. 

Note: You can adjust the size of the left section of the search, and hide or display this section as well (see 

Viewing and Managing Your Images). 

Tip: If you‟re searching a site with multiple locations, list your images by detail view so that the location of each 
image found in the search is also displayed (as shown in the preceding example). 

Tip: To clear the results of your most recent search, click Clear. 

Note: When you‟re viewing images in your search results, you can view any image as full size on the right side of the 
search window, move through images in the list using the navigation buttons underneath the full size image display, 
display images as a slideshow, zoom in and out on images, copy images to your favorites, save images to another 
folder on your computer, export image data, move or copy images to another location, and delete images. All of 
these tasks are the same as those described in View Images. 
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Tag Images and Manage Image Data 

Click the Image Data button  to open the Image Toolbox. 

 
 

The Image Toolbox has three sections: 

1. Toolbox Controls/Setup: 

 The  button is used to close the Image Toolbox. 

 The  link is used to control whether the Image Toolbox is docked/anchored within the Image 

Viewer or is allowed to “float” and be moved/positioned independently of the Image Viewer. 

 The  link opens the Tagging setup window to allow you to customize your Hit List and Counts: 
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2. Hit List and Counts: 

 

 The    buttons are used to collapse or expand each section. 

 The checkboxes are used to “Tag” an image to mark that it contains the selected Hit List buck. The 
Hit List page in the BuckView main window will display all of your Hit List bucks with a thumbnail 
image of each and counts showing how many images have been tagged with that buck at all of 
your sites and locations with links to quickly view just those images. 
 
Tip: The first 9 Hit List bucks have keyboard shortcuts of Ctrl+# that allow you to check/uncheck 

the buck without using your mouse. 

 The Counts section can be used to gather census about your property. You can “Tag” each image 
that contains the selected species and enter a count of how many animals are in the image. 
 
Tip: The predefined values of Bucks, Does and Fawns include keyboard shortcuts (such as Ctrl+B) 
that you can used to select the checkbox and increment the count. So pressing Ctrl+B 3 times 
would check the Bucks checkbox and set the count to „3‟. (Note: Ctrl+Shift+B will decrease the 
count) 

 

3. Notes / Metadata 
 
Notes are any text you wish to add to your images. 
 

Metadata is data about the image that was captured by your RECONYX camera. 



www.reconyx.com 31 

Create Video 

Select a group of images and create a video clip using any of the images you‟ve stored in a location in “BuckView.” 
The video you create is saved as an .AVI (Audio Video Interleave) video and can be viewed using a number of widely 

available media players, including RealPlayer® and Microsoft Windows Media® Player. 

Within the “Viewer,” select the images you want to include in the video clip (the process of selecting multiple images 
is described in View Images).  

Once you have selected the images you want to use to create your video, from the Image drop-down menu, select 
Create Video, browse to the folder you want to save the video in, enter the file name you want to give the video, and 

click Save. The progress of creating your video is displayed. 

Tip: You can also click the Create Video toolbar button.  

To view your video, browse to the folder where you saved it and double-click the file. The video will play in your 

default video player. 

Tip: The default location where videos are stored is your My Favorite RECONYX Images folder; if you save your 
videos in this folder, you can access them quickly from BuckView by opening your Favorites folder (see Favorites). 

The video clip file can be attached to an email for sharing images with friends and colleagues and/or inserted into 
presentation tools such as Microsoft PowerPoint®.   

Note: Video files can become quite large depending upon the number of images included in the video. As a guide, 10 
images from the RapidFire camera will result in a video file of about 500KB, and 20 images will create a video file 

around 1MB in size. 
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Hit List 

Hit List is a simple way to find / view the images of your favorite bucks.  
 
In any image viewer (Viewer, Search, Import), use the Image Toolbox to setup the names of the bucks you track 

closely.  

When you are reviewing your images, be sure to “Tag” the images that contain one or more of your Hit List bucks. 

From the BuckView main window, click on the  button to go to the Hit List control. The Hit List control lists 
all of your Hit List bucks with a sample thumbnail photo of each: 

  

 

RECONYX News 

The RECONYX News page will keep you up-to-date with the latest happenings at RECONYX, such as camera sales, 

new product announcements, photo submission contests and more. 
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Warranty and Safety Information 

Satisfaction Guarantee 

RECONYX offers a 30-day satisfaction guarantee for all products that are purchased directly from RECONYX. If, for 
any reason, you are not completely satisfied with products purchased from RECONYX, you may return the products 

within 30 days of purchase for a full refund of the purchase price and applicable taxes. 

This guarantee is subject to the following conditions: 

 You must obtain a Return Material Authorization (RMA) number for all products returned under this money-
back guarantee (contact RECONYX for an RMA before returning products). 

 You must return the original CDs containing RECONYX software and will be required to sign an affidavit 
indicating that all copies of RECONYX software have been removed from your computers and any physical 

copies of the software have been destroyed. 

 Shipping charges will not be refunded. 

Limited Warranty 

Software products are licensed to Buyer under the terms of the applicable RECONYX software license (contained 
within installation programs). If Buyer wishes to review the software license agreement before purchasing products 

from RECONYX, a copy of the software license may be obtained by request. 

Buyer must obtain a Return Material Authorization (RMA) number from RECONYX before returning any product(s) 
for repair or replacement. If RECONYX concludes that a returned product is not defective, Buyer will be notified, the 
product will be returned to Buyer at Buyer‟s expense, and Buyer may be charged for RECONYX‟s examina tion and 

testing of the product. 

This limited warranty is the sole warranty for software products offered by RECONYX and RECONYX shall not be 

liable for any amounts for said products except in compliance with this warranty. 



34 © RECONYX, Inc. 

Troubleshooting and Technical Support 

For answers to questions about BuckView for which you cannot find answers in this User Guide, please check the 
RECONYX web site (www.reconyx.com) to see if the information you are looking for is covered in the on-line 

“Frequently Asked Questions” (FAQ) section. 

If after searching this User Guide and checking the FAQ‟s on the web, you still have questions that you need 
assistance in answering, please email RECONYX technical support (support@reconyx.com) or call us at 866-493-

6064 and ask for Technical Support.  We will do everything we can to help you get the most from BuckView. 

Troubleshooting Your BuckView Software 

If you cannot see your customized Image Data (e.g. in Microsoft Excel®) after exporting tagged images, you must 
change the alignment of the cells containing keywords in order to make the data visible. The default alignment when 
opening a .CSV file is Bottom. Select the cells for which you wish to change the alignment and from the Format 
menu, select Cells. In the window that appears, click the Alignment tab. Change the Vertical setting to a more 

appropriate value, Top, for example. Click OK and your data should appear in the selected cells. 

If you receive error messages while loading new images, this could be the result of either bad images or 
incompatibility.  If you see an error message that says, “Error Importing Image <filename> Cause:  Error reading JPG 
Comment”, this would indicate a bad image was skipped.  If the error message reads, “Error Importing Image 
<filename> Cause: Image could not be imported due to version incompatibility.” this would indicate that the images 

you are trying to load were captured with a camera that is incompatible with “BuckView.”  

If you receive error messages while loading images from another folder - it may be because there are too many 
characters in the path to the files (more than 130 characters). To read more about this known issue or to obtain a fix, 
go here. A simple solution is to rename or move the folder you are trying to load from. If the full path to the folder can 
be shortened to fewer than 130 characters, this problem will go away. If this does not solve your problem with loading 

images from another folder, contact Technical Support. 

If you cannot erase your memory card, check with computer technical support personnel to be sure you have 
permissions set on your computer to allow you to format removable media. The instructions below explain how the 
appropriate privileges can be assigned. 

Determine the version of your operating system.  Follow the steps outlined below for your operating system.   

 

Windows XP Home Edition 

From a user account with Administrator privileges: 

Click Start, click Run. Enter regedit at the prompt. 

Browse to: HKEY_LOCAL_MACHINE\Software\Microsoft\WindowsNT\CurrentVersion\Winlogon 

On the right side, find AllocateDASD. 

Double Click AllocateDASD, and change the value to 2.  Click OK.   

Close the Registry Editor. 

The next time the user logs in, they will be able to erase their memory card.   

http://www.reconyx.com/
mailto:support@reconyx.com
http://support.microsoft.com/default.aspx?scid=kb;en-us;830920
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Window XP Professional Edition 

From a user account with Administrator privileges: 

Click Start, click Run. Enter mmc at the prompt. 

Under File, click on Add/Remove Snap-in… 

On the Add/Remove Snap-in window, click Add.   

On the Add Standalone Snap-in window, choose Group Policy from list and click Add. In the wizard 
window that appears, make sure that Local Computer is typed in the Group Policy Object text box and 

click Finish. 

Click Close on the Add Standalone Snap-in window. 

Click OK on the Add/Remove Snap-in window. 

Under Local Computer Policy, browse to the following branch: 

Computer Configuration\Windows Settings\Security Settings\Local Policies\Security Options 

Right click on Devices: Allowed to format and eject removable media and click Properties. 

In the Local Security Setting box, click the group you want, and then click OK.  

Your choices are:  

Administrators - Only Administrators can format removable media.  

Administrators and Power Users - Admin and Power users can format removable media.  

Administrators and Interactive Users - Administrators and Interactive (Limited users) can format 

removable media. 

Quit MMC, click Start, and then click Run. Enter gpupdate at the prompt. 

The next time the user logs in, they will be able to erase their memory card.
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This manual provides detailed instructions for viewing and managing with BuckView Advanced software. 
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